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Creating universal traffic data format (UTDF)

* Input:
Interval n Approach n Movementﬂ Class ﬂ Volume n
7:00 AM Southbound R Motorcycles 0
7:00 AM Southbound RoR Motorcycles 0
7:00 AM Southbound T Motorcycles 0
7:00 AM Southbound L Motorcycles 1
7:00 AM Southbound U Motorcycles 0
# Output:
TIME INTID |EBL lEBT EBR WBL WBT WBR NBL NBT NBR SBL SBT SBR
7:00 AM 21 211 449 0 0 621 112 275 0 304 0 0 0
7:00 AM 22 0 533 382 265 656 0 0 0 0 125 0 222
7:00 AM 7 0 0 0 0 0 0 0 0 0 0 0 0
7:00 AM 5 18 74 66 1 192 2 18 8 0 8 32 60
7:00 AM 6 31 125 0 0 235 35 90 0 33 0 0 0
7:00 AM 8 0 89 122 161 172 0 0 0 0 67 2 34
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Creating Additional Columns

# Create date and time columns to split time and date in “Interval” column
- insert a column for date, format the cells as date

Format Cells

Category:

General
Number
Currency

ACCOUF\tini

Time
Percentage
Fraction
Scientific
Text
Special
Custom

? X

Font Border Fill Protection

Sample
5/1/2018

Iype:

March-12 ~
March 14, 2012

3/14/12 1:30 PM

3/14/1213:30

M

M-12
3/14/2012

- insert a column for time, format the cells as time

Format Cells ? X
Number Alignment Font Border Fill Protection
Category:
General Sample
Number 7:00:00
Currency
Accounting Type:
Date *1:30:55 PM A
UL 13:30
Percentage 1-3;0 PM ﬁ
Fraction ==
Criantifis 13:30:55 CAMBRIDGE SYSTEMATICS



Creating Additional Columns

% In Date column, type the formula:

SUM vl i | X  J | =INT(C2)

_ Time M Interval M Approacn Movemenﬂ TurnDefﬂ Classﬂ volumBd
2 |=INT(C2) 7:00:00!I 7:00:00 AM I!'Southbound R SouthboundR vlotorcycles 0
3_] 5/1/2018 7:00:00 7:00:00 AM  Southbound RoR SouthboundRoRvlotorcycles 0

# In Time column, type the formula:

SUM v| i X Vv Kk =[@Interval]-A2

Date M Timen Intervalﬂ Approacﬂ Movemen- TurnDefﬂ Classn Volumn
5/1/2018|=[@Interval 7:00:00 AM | Southbound R SouthboundR vlotorcycles 0
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Creating Additional Columns

# Create Turn Def column (combining approach and movement columns)

SUM v| X Vv K =[@Approach]&E2
A A B C D E F
1 ﬂ Time ﬂ Interval ﬂ Approachg

| | |
2 5/1/2018 7:00:00 7:00:00 AM | Southbound | R |=[@Approach]4

- An A~ s —_ - - - — -
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Create Simple Pivot Table

» The purpose is to observe day to day variation of the
data

» Select all data range
» Click on insert-> Pivot Table

@ Arrange the data as shown in the next slide
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Create Simple Pivot Table

PivotChart Fields v

S CENGInE Columntabels E} Choose fields to add to report: ’ v !
Row Labels .7 5/1/2018 5/2/2018 5/3/2018 Grand Total o 0 Sesch 5
=7AM 900

:00 293 304 300 897 V| Date Y

115 434 458 423 1315 800 V| Time

30 557 543 536 1636 (] Interval

45 641 624 633 1898 | 700 L] Approach
58 AM ["] Movement

00 s2 510 525 1657 |60 L] TumDef

15 554 562 538 1654 L Class

20 ss1 483 a4 158 |0 oate Y e Ve

45 50 487 SM 1570 —5/1/2018 /1 Houts Y
=9AM 0400 —5/22018 ()
0 0 1 1 2 T 532018
=4PM Drag fields between areas below;

0 el AR o Y FILTERS 1I| LEGEND (SERIES)

15 72 6% 720 2148

30 84 735 TN 2% |00 | Date ¥

45 694 661 716 2071
=5PM .

:00 733 752 761 2246 00 A5 30 45 00 15 30 45 00 00 15 30 45 00 A5 30 45 00

15 732 763 T4 2241 7AM 8AM 9AM 4P 5 PM 6PM

30 673 669 665 2007 |

45 675 605 623 1903 oYl e v o ke 5 = AXS(CATEG.. % VALUES
56PM _Hours | Sum of Volume v
700* 2 0 1 3 | Time v 7‘
Grand Total 9910 9648 9687 29245 '
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Create Average Table

@ create 3 separate work sheets for every date

Filter the column “date” for the desired day
Find&Select-> Go To Special

Select “Visible Cells Only”

Copy and paste the table in new worksheet

Go To Special
Select
A p (O Comments
—~ -~ (O Constants
oo E O cormut
[ O Find.. Numbers
ab_ Replace... e
S ot Logicals
. Errors
Go To Special... O Blanks
Formulas (O Current region
Comments O Current array
Conditional Formatting O Objects
Constants

Data Validation
[ Select Objects

EL;, Selection Pane...

(O Row differences
(O Column differences
(O Precedents
(O Dependents

Direct only

All levels
(O Last cell

(O Conditional formats
(O Data validation

All

Same

ok || cancl
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Create Pivot table from the Average table

¥ create a new table where the column “Volume” is average (or rounded
average) of 3 days.

# Create a pivot table based on this table.
# Make sure time is displayed in 15-mminute interval
# Group classes to passenger car (PC) and truck

# Sort the header (TurnDef) as appears in the UTDF format

CAMBRIDGE SYSTEMATICS i




Pivot Table Field arrangement

A B C ‘ D E ‘ F G | H I J
] PivotTable Fields e
i Sum of Volume Column Labels M Choose fields to add to report: E’
|Row Labels E EastboundL EastboundR EastboundT WestboundL WestboundR WestboundT NorthboundL NorthboundR Northb| iS&arch ,O‘
|=7AM
=:00 0.333333333 0 0 0 0.666666667 0 2333333333 0.333333333 (] Date
| Articulated Trucks 0 0 0 0 0 0 0 0 5.666 [v] Time
| Bicycles on Road 0 0 0 0 0 0 0 0 L] Interval
| Buses 0 0 0 0 0 0 0 0 (] Approach
I Cars 0 0 0 0 0.666666667 0 1 0.333333333  113.6 [| Movement
Il Light Goods Vehicles | 0.333233333 0 0 0 0 0 0.666666667 0 V] TumDef Y
Motorcycles 0 0 0 0 0 0 0 0 0333 /! Class
1 single-Unit Trucks 0 0 0 0 0 0 0.666666667 0 6.333 ;"‘ Volume
| =uas 0.666666667 0.333333333 0 1 0 0 3 2 4] Hours
| Articulated Trucks 0 0 0 0 0 0 0 0 MORE TABLES...
Bicycles on Road 0 0 0 0 0 0 0 0 0.333
Buses 0 0 0 0 0 0 0 1 Drag fields between areas below:
Cars 0.333333333 0 0 0.666666667 0 0 1 1
] Light Goods Vehicles 0.333333333 0.333333333 0 0.333333333 0 0 2 0 ¥ FLTERS _ Pl s
| Motorcycles 0 0 0 0 0 0 0 0 0.333 TurnDef M
| Single-Unit Trucks 0 0 0 0 0 0 0 0 10.33
=:30 0.333333333 0 0 1 0 0.666666667 5 2 3426
Articulated Trucks 0 0 0 0 0 0 0 0
| Bicycles on Road 0 0 0 0 0 0 0 0 0.666
| Buses 0 0 0 0 0 0 0 0
| Cars 0 0 0 1 0 0.333333333 1.333333333  1.666666667 243.3 = ROWS 3 VALUES
| Light Goods Vehicles 0.333333333 0 0 0 0 0.333333333 3.666666667 0.333333333 80.66 T ~ IMl Sum of Volume ~
Motorcycles 0 0 0 0 0 0 0 0 Time -
Single-Unit Trucks 0 0 0 0 0 0 0 0 Class =
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Desirable Time Aggregation

H = = Book1 - Excel PivotTable Tools

File Home Insert Page Layout Formulas Data Review View Add-Ins Team Analyze

[  ActiveField: += | Group Selection | [&] Insert Slicer D [‘% [# Clear~ G

- = ~i o
. Time _ _ @E Ungroup 7 Insert Timeline i [T} Select ~
PivotTable Drill  Drill == v Refresh Change Data
- i@ Field Settings Down Up - Group Field 7| Filter Connections = ST CE [3 Move PivotTable O
Active Field Group Filter Data Actions
A5 v J | 7AM
Grouping ? X
Auto i
£ Starting at: | 7:00:00 AM E ' : ' = ' H

1 :
5 m Ending at: » 6:00:00 PM
3 : Sum of Volume Columi &
4 | v Eastboy _3econds WestboundL WestboundR WestboundT Northbow
5 | | . 2.666666667 1.666666667 0.666666667 16.66666
6 Articulated Trucks = 0 0 0

] Months
7 | Bicycles on Road Quarters 0 0 0
8 |  Buses Ness 0 0 0
9 Cars 0 - | 2.333333333 1.666666667 0.333333333 5.333333

— Number of days: |1 o
10| Light Goods Vehicles 1 0.333333333 0 0.333333333 10.33333
11 Motorcycles “ ' ‘ 0 0 0

— Cancel
H [oc ]

Single-Unit Trucks ’ ' 0 0 0 4&
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Group Classes

# Click and hold Ctrl to select classes that you want together, click on Group
Selection, and rename the selection. Create groups for PC and Truck

H ©-¢&- = Book] - Excel

File Home Insert Page Layout Formulas Data Review View

Active Field: I +—= | = Group Selection Insert Slicer
&) | = P
cl " gBu 3 Insert Timeli
PivotTable mass SE e e _E ngroup | 7 nsert Timeline
- 1@ Field Settings  pouwn Up = | |[7] Group Field U[¥] Filter Connections
Active Field Group Filter
All v | : £ Mc Group Selection

Create a group containing the
selected items.

A B | C | D | E
1 —
2 —
3 |Sum of Volume Column Labels [I‘l’]
4 Row Labels E EastboundL EastboundR EastboundT Westbou
5 |Z7AM 2 0.333333333 0.666666667 2.66666!
6 Articulated Trucks 0 0 0
7 Bicycles on Road 0 0 0
8 Buses 0 0 0
g Cars 0.666666667 0 0.333333333 2.33333!
10 Light Goods Vehicles 1.333333333 0.333333333 0.333333333 0.33333!
11| Motorcycles | 0 0 0 ﬁ
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Sort the Header

» Desired header sorting is:

EBL EBT EBR WBL WBT WBR NBL NBT NBR SBL SBT SBR

2 sort the header as desired somewhere.

A B C D E F 6 H | J K L

| | | | | | | | | J

EastboundL EastboundR EastboundT WesthoundL WestboundR WesthoundT NorthboundL NorthboundR NorthboundT SouthboundL SouthboundR SouthboundT

* File-> Options—> Advanced-> General-> Edit Custom Lists, select the range
and click “Import”.

2 Get back to the Pivot table, click on the header, sort from Ato Z

CAMBRIDGE SYSTEMATICS i
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Turning Movement Count

» Add date and intersection code to the raw table

* With pivot table, arrange the data as desired and evaluate the data

consistency
Sum of Volume Movemeljyg
Interval Hours Interval 4/24/2018 4/25/2018 4/26/2018 Grand Tota
=1112
=7 AM
200 154 149 151 454
15 240 223 234 697
30 267 270 266 803
45 418 379 389 1186
-8 AM
00 337 338 336 1011
15 316 368 310 994
30 344 330 331 1005
45 325 347 368 1040
5 Grand Total o 2401 2404 2385 7190 o

o0 Day to day variation of AM
Southbound Through

Date v
250 -8 4/28/2018
- 4/25/2018 ()
—t 4/26/2018

ey 15 ) a5 0 15 = a5
7AM 8AM ﬁ
IiCode W Hows W Ineval [ o=
~ T T T 2z A -~ CAMBRIDGE SYSTEMATICS
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Turning Movement Count Coding

# Create a .bin table: File-> New-> Table - Fixed_format binary

» Add these attributes: FromLink, ToLink, Node, Count_700, Count715, etc

New Table ? x| B8 A AE A Do ¢
Table Structure ] (= [=][=]
Field Name Type |Width | Deci | Index | Defaultl Format Display Name | | OK I '
FromLink Integer (4 bytes) 8 ] None Cancel 844060
ToLink Integer (4 bytes) 8 O None [ Add Field | 7640
ie : . :
Neode Integer (4 bytes) 8 ] None r i Dataview1 - MyTumning E
Drop Field @ FromLink| ToLink|  Node|Count_700|Count_715|Count_730|
Count_700 Integer (4 bytes) 8 O None ﬁ : 4809 7640 842118 54 110 88
Count_715 Integer (4 bytes) 8 O None Move Up
Integer (4 bytes) 8 O None Move Down
(=2}

+ Depends on how many counts collected, it mightT)e easier to automatically
create .bin files such as turning delay (created by TransModeler) and edit the
file, instead of creating one from scratch.

CAMBRIDGE SYSTEMATICS i
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Segment Count Coding

Modify Table ? X

# Set the current layer to Segment ...

Field Name IType |Width | Decil Index | Defaultl Format Display Name l A
. . FA_NO Character 10 O None Cancel
» Dataview—->Table> Mod Ify DONCHRP Integer (4 bytes) 8 0 None [adarea |
BASEVOL Real (8 bytes) 10 2 None -
ABDaySpd  |Real @bytes) |9 |2 S None Drop Field
) Add attributes . AB Cou nt 700 BA_DaySpd Real (8 bytes) 9 2 O None ’ Move Up ‘
' —_ — ’ AB_DyFlow Real (8 bytes) 9 2 O None AT
BA_Count_700, AB_Count_7:15, [sofer e & 2 0
= = ’ — — ? |TotDyFlow  Real@byte) 9 2 | [ None Attach Codes
B A Cou nt 7 1 5 etC SUBAREA_SET | Integer (4 bytes) |10 0 None Drop Codes
— i ’ ’ CLASS Integer (4 bytes) |12 O None Export Codes
Integer (4 bytes) 12 O None

» Fill them with available counts for the associated segment.

Dataview1 - Segments Info

ID 7642
4B_DaySpd 28.49
BA_DaySpd 28.45
AB_DyFlow 15000.78
BA_DyFlow 15378.42
Tot_DyFlow 30379.20
SUBAREA_SET 1
CLASS 203
AB_Count_700 1200
BA_Count_700 G | ﬁ
CAMBRIDGE SYSTEMATICS
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Indirect segment Count

17

» Matrix estimation process does not produce turning volume output, but only
segment volume output. Therefore, to see how well our turning movements
are replicated, we need to generate segment count from the observed

turning counts.

» TrnasModeler can create “link” count based on turning counts which is
explained in next webinar. The counts can be added as attributes to link
layer. Link layer then should be joined to the segment layer, so segment
attributes for count could be filled with link count attribute (as discussed
earlier, there is no 1-1 relation between link and segments, sometimes a link
can include more than a segment)

» Segment counts should be spot checked to make sure link to segment
join/attribute transfer is done properly.
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Generating Turning mo
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Runs

Reports

| o | |

. L. Trip Histogram

4- Flow & Travel Time

-- Delay

~ Queues

4- Sensor Data

EI Output Tables

: Travel Time Tables
Transit Travel Time Tables
Turning Movement Table

. .. Path Flow Table

- Emissions

From |08:00:00 |24 To |09:00:00 |2

Interval minutes

Selection |AII Records

~ |

vement Volume
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Generating Turning movement Volume

» Each Transmodeler simulation run, automatically produces a file “simulation
name”+Turning Movement Volumes.bin that looks like this:
Dataview1 - Turning Movement Volumes

FromLink| ~ Node|  ToLink|Dir [Type| Facility[Vol_0800|Vol 0615/Vol_0630|Vol_0645(Vol 0700[Vol_0715|Vol 0730[Vol_0745|Vol_0800[Vol 0815[Vol_0830[Vol 0845  Vol| A
8102 1239 5815W R - 0 0 0 0 0 0 0 0 0 0 0 0 0

r

8102 1239 5789w T 0 0 0 0 0 0 1 0 0 2 1 2 6
8102 1239 5791W L 1 1 0 0 1 0 1 0 1 6 3 5 19
5815 1239 57895 R 0 0 0 0 0 0 0 0 0 0 0 0 0
5815 1239 57915 T 0 0 0 0 0 0 0 0 0 0 0 1 1
5815 1239 81025 L 0 0 0 0 0 0 0 0 0 0 0 0 0
5789 1239 5815E L 0 0 0 0 0 0 0 0 0 0 0 0 0

# This bin file can generate volume for any user-specific time period, if
generated through Output Manager: (you may be asked to identify the run
based on which you want this output)

CAMBRIDGE SYSTEMATICS i
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Generating Turning movement Volume

# Before running the simulation:

1- ldentify how many runs are needed (more than 1 run is usually desired to

smooth out the results and lower the variations between runs due to simulation
stochasticity)

2- Make sure for each scenario, the inputs are correctly defined in Project

Settings (network, trip matrix, signal timing file, historical travel time, parameter
files)

If you input a TM table, you can visualize the values at any controlled
intersection.

Project - Settings 2 Network - Turning Movement Variables browse and find
the desired file, save the simulation database.
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Generating Turning movement Volume

¥ Open the Intersection Toolbar. Click on any controlled intersection, under
“Turn” tab, you can visualize the turning volume.

B Intersection Control Editor (Signal Timings\Base Timings.tms) X

Control ‘Swp or Yield v Node 1888 v

General Tums  Stop/Yield Signs
Diagram Tum Movement Table
File F:\ijeds\Eleka\GEA_Transmdeler\DVm\DVD1 |_test\Output\Bas...\Tuming Movement Volumes bin

Field | Vol_0600 vl

From\ To 57| HUMBOLDT ST | HUMBOLDT ST |
HUMBOLDT ST & =& -
HUMBOLDT ST & 03 = 0
IST i 36| 9 1P 0

21

rsections
o2 55 b %+ B
Turn Field [Vol 0600 v
INone vl
[HumBoLDT 5T v]
[isT -]
as
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